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1. Introduction
This manual is about POPmail for IBM and compatible microcomputers that run the 
MS-DOS operating system.    In this document, for the sake of simplicity, we will often refer 
to these computers as IBM’s or PC’s.    POPmail is an electronic mail (E-mail) system, 
written by microcomputer support staff at the University of Minnesota. With the POPmail 
program, you can send and receive E-mail messages locally or to and from large systems on 
campus and around the world.    In addition to POPmail for the IBM, we also support an 
Apple Macintosh version, although all references to POPmail in this manual will pertain only
to the IBM version unless otherwise specified.

POPmail uses the standard IBM character set to emulate a graphical user interface (GUI).    
For this reason, POPmail runs on a wide range of IBM PCs and compatibles, including the 
earliest PCs which contained a monochrome display adapter (with no graphics support).    In 
other words, POPmail does not require that you install a special graphics display adapter in 
your computer.

With a GUI, you interact with the program by responding to graphical symbols on the 
computer screen, rather than by issuing single line commands (as with the MS-DOS 
operating system).    Because of its intuitive user interface, POPmail is largely self-
explanatory and very easy-to-use.    If you are familiar with the GUI in Microsoft Windows or
the Apple Macintosh operating system, you will be able to run POPmail without much help 
from this manual.

We allow free distribution of POPmail to all interested parties provided that our copyright 
notices are not altered or removed and you do not charge others for distribution of our 
software.

1.1           Help!  
If you run into difficulties when installing or using POPmail, you should first contact your 
local network administrator.    If you have questions, bug reports, suggestions, or general 
comments about POPmail you can send E-mail to us at

                    popmail@boombox.micro.umn.edu

or if you prefer paper mail

                    POPmail Project
                    University of Minnesota
                    Room 125 Shepherd Labs
                    Minneapolis, MN 55455
                    U.S.A.

In all of your correspondence pertaining to POPmail, please

                    •    Indicate your POPmail version number.
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                    •    Indicate your operating system and version number (e.g., DOS 3.2).
                    •    If possible, send us a diagnostic record of your POPmail session.
                            (See the "Trace Facility" section of this manual for further details.)

Additional help information is available in the "POPmail Questions & Answers" section at 
the end of this manual.

1.2           Background and Philosophy  
To be widely effective, an E-mail system must embody these three qualities wide 
connectivity, ease of use, and reasonable cost.    We designed POPmail with these three goals 
in mind.

Wide connectivity is crucial because most people don’t want to use three or four different E-
mail packages to communicate with colleagues who use different computers.    You can use 
POPmail to send and receive E-mail to and from the academic computer center mainframes 
on campus as well as between departmental workstations.    Moreover, you can use POPmail 
to exchange E-mail with other computers on the worldwide internet (CICNET, NSFNET, and
MRNET) and on BITNET.    Many mainframe computers and workstations have mail 
programs with wide connectivity, but often, these E-mail programs are difficult to learn and 
use.    For this reason, we developed POPmail to provide wide connectivity in a user-friendly 
environment.    In addition, POPmail is free (in the public domain).

POPmail’s name is derived from Post Office Protocol (POP), the protocol that defines how a 
computer can retrieve mail from another computer (which acts as a shared post office or 
mail-server).    POPmail uses either the POP2 or POP3 protocol to communicate between 
POPmail and a mail server.

1.3           Selecting a Host Mail Server  
POPmail requires a host computer to act as a central shared mail server.    Several host 
options are available to you.    If you are affiliated with the University of Minnesota, the 
easiest option is to sign up for mail-server-only service with the mainframe division of CIS 
(the University’s Computer and Information Services department). For $20 per year, the 
mainframe division will provide those in the University community with unlimited access to 
the mainframe mail-server.    (For further information about this service, you can call CIS 
Accounts at 612-625-1511.)

If you have access to a Unix-based computer in your department or work group, you may 
want to use that machine as your host mail server.    Examples of small Unix hosts include 
SUN workstations, NeXT computers, or Apple Macintosh IIs running the A/UX operating 
system.    Computers of this size should be adequate for servicing around 150 POPmail users. 
Because Unix machines have excellent connectivity to other systems, they are a good choice 
for a mail server.    Of course, for full connectivity, any mail server you select must be 
connected to the backbone network in order to communicate with the rest of the campus and 
the world.
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Any reliable E-mail system will require a post office machine (or host mail server) to hold 
mail that arrives when a user's microcomputer is turned off.    The host mail server should be 
available 24 hours a day to receive and store all incoming mail messages until it is 
convenient for the user to read them.

Another low-cost option you can consider for a host mail server is to use the University of 
Minnesota's MailStop program.    MailStop is a mail-server application that runs on 
Macintosh computers.    This server software is designed to service client workstations (either
IBM-compatibles or Macintosh computers) that run POPmail.    MailStop is in the public 
domain and is included as part of our overall POPmail package.    This means that MailStop, 
along with POPmail, is available from us via anonymous FTP on the internet.    (See the 
"Configuring POPmail" section below for details.)

In any case, to use POPmail, you designate one machine as a post office (also known as a 
POP server).    Incoming mail is held in your mailbox on the post office server until you use 
POPmail on your microcomputer to call for the mail.    This process is similar to having your 
paper mail held for you in a P.O. box at the U.S. Post Office.    Like the paper mail user, those
who use POPmail don’t need to know how the post office business works; they just need to 
know how to collect their mail.

Figure 1 is a diagram of a worksite that uses a mainframe computer as the mail server; the 
server is connected to the campus-wide backbone network.    The worksite is running 
POPmail on both IBM and Macintosh microcomputers.    The IBM computers on the top of 
the diagram are connected to the campus backbone network by Ethernet cable and a 
LANmark Ethernet telephone Type LDI-410.    (Making a connection to the Ethernet 
backbone may entail running wires for the network and setting up a LANmark phone 
connection.    If you are on the University of Minnesota phone system and you do not have 
the wiring and phone in place, call Telecommunications Services at 612-625-6333.)

Figure 1    Sample POPmail Setup

2. The POPmail User Interface

The POPmail screen consists of two full-sized windows.    The Viewer Window is for 
viewing messages which have been sent to you.    The Composer Window is used to compose
new messages to send to others.

In addition to POPmail's two full-sized windows, smaller windows, (dialog boxes) pop up 
from time to time in response to commands you issue or buttons you click.
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2.1           Menu Bar  
The very top line of the computer screen contains POPmail's menu bar with six menu labels.  
The menu bar looks like this

                          ∫      Options      Edit      Group      Memo      Window    Help

The menu bar is the primary mechanism you use to communicate with the POPmail program.
The menus have "pull-down" labels; that is, when you select Edit in the menu bar, a list of 
specific editing commands are dropped down from the Edit menu label and displayed in a 
list. If one of the commands in a pull-down menu is followed three periods (...), a modal 
dialog box (explained later in this section) will be displayed when you select that command.   
If a command in a pull-down menu is not followed by three periods, this means that once you
choose it, the indicated action will occur immediately.

You can use either a mouse or keyboard to select commands.    To use a mouse, click on the 
desired menu title to display the pull-down menu. (Use only the left mouse button if your 
mouse has more than one button).    Then click on the desired command.    Alternatively, 
instead of clicking, you can push the mouse button over a menu title and then continue to 
hold the mouse button down while you move the mouse cursor straight down from the menu 
title to the desired menu command, and then release the mouse button.    If you decide not to 
choose a command, just move the mouse cursor out of the boundaries of the pull-down menu
and release the mouse button.    Then no action will be performed.

To choose menu commands using the keyboard, first pull down the menu.    You do this by 
pressing the F10 key to make the menu bar active.    (When the menu bar is active, one menu 
title is highlighted.)    If the menu title you want is not the one currently highlighted, use the 
arrow keys to move to the right or left along the menu bar, until the menu title you want to 
select appears highlighted. (Alternatively, you can just type the first letter of the menu title.)   
Then press the <ENTER> key.    This will cause the menu to pull-down (drop-down).    There 
also is a hot-key alternative method to pull-down a menu.    Hold the Alt key down while 
typing the letter corresponding to the first letter of the menu title you want (e.g., type Alt-G 
to pull-down the Group menu).  The hot key to pull-down the ∫ menu (called the system 
menu) is Alt-Spacebar.

Once the menu you want is pulled down, use the up-down arrow keys to highlight the 
command you want and press <ENTER> to choose (perform) the highlighted command.    
(As a shortcut    press the key corresponding to the highlighted letter of the desired command 
in order to choose that command.)

Once you choose (perform) a menu command, POPmail will do one of two things    carry out 
the command directly or display a modal dialog box.

The individual items under the pull-down menus are organized as shown in the following 
table.    Highlighted letters (shown here as capital letters) are used to perform the various 
short-cuts described in the previous section and elsewhere in this manual.
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Note that the highlighted letter (shown here as a capital letter) associated with each command
is not always the first letter of the command.    In addition, some menu commands are 
considered to be so important that they can be activated with a hot key alternative.    These 
hot keys are also shown below.
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Menu Title Commands Hot-key

∫
About...
----------
Calculator
calenDar
ascii Table
Video mode
Ip finder
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Finger
Options

pReferences...
Configure... Alt-C
----------
pRinter setup...
Print Alt-P
----------
Trace Alt-F10
----------
eXit Alt-X

Edit
Undo
----------
cuT Shift-Del
Copy Ctrl-Ins
Paste Shift-Ins
----------
Find... Ctrl-QF
Replace... Ctrl-QA
search Again Ctrl-L
----------
cLear composer

Group
Make group...
Select group... F5

Memo
Change Dir...
----------
Open
New
Save F2
Save As...

Window
cLose Alt-F3
Resize/move Ctrl-F5
Next window F6
Zoom
Tile
cAscade
----------
Viewer F7
Composer F8
Show clipboard

Help
Contents
Index Shift-F1
Previous topic Alt-F1
Help on help
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2.2           Status Bar  
POPmail's status bar is located across the bottom line of the screen.    The status bar looks 
like this

F1 Help      Alt-X    Exit          Alt-F    Fetch        F3    Prev Msg          F4    Next Msg          F7    View        F8    
Compose

The status bar contains "hot spots."    Hot spots are located wherever words occur in the status
bar.    For example, "F3 Prev Msg" constitutes one hot spot.    Hot spots are separated from 
each other by more than one space.      When you click on a hot spot with a mouse, the 
indicated function will be carried out.    For example, when you click on the words "F4 Next 
Msg", POPmail displays the next message stored in your mail database, and when you click 
on the words "F8 Compose", POPmail opens the Composer window, allowing you to 
compose an outgoing mail message.

To activate a hot spot without using a mouse, you type a hot-key.    For example, if you press 
the F8 function key, POPmail will display the Composer window; and, if you type Alt-X, you
will exit from the POPmail program.

2.3           Dialog boxes  
Once you execute a menu command, POPmail will do one of two things    either carry out the
command immediately or display a dialog box.    If a menu command is followed by three 
periods, (e.g., Save As...), the command opens a modal dialog box.    A modal dialog box is 
essentially a question-and-answer session which requires you to select choices and fill in the 
blanks before POPmail will proceed.    Note that while a modal dialog box is displayed, the 
menus and status bar hot spots are inactive.

In order to set options in a dialog box, you use five on-screen gadgets.    These five gadgets or
"controls" are    radio buttons, check boxes, software buttons, list boxes, and input boxes.    
Figure 2 shows a dialog box illustrating the five controls

Figure 2 Modal Dialog Box

2.3.1         Software Buttons  
With a mouse, you choose a software button by moving the cursor pointer over the button 
and then clicking the mouse button.    The modal dialog box shown in Figure 2 has two 
software buttons oK and Cancel.    If you choose oK, the choices you select in the dialog box 
are instituted.    If you choose Cancel, nothing happens and the dialog box goes away without 
instituting any of your changes.

If you don't have a mouse, use the keyboard command equivalents to choose and activate a 
button.    Press the <TAB> key consecutively to advance forward through the dialog box until
the button you want to select becomes highlighted and then press the <ENTER> key to 
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choose that software button.    (Press Shift-<TAB> to move backwards in a dialog box.)    
When you have finished making your choices in a dialog box, type Alt-K (to activate the oK 
button).    To cancel, type the ESC key.

2.3.2         Input Boxes  
Input boxes let you enter text.    For example, in one of POPmail's dialog boxes, POPmail 
requires that you enter your full name in an input box. If you type in more text than will fit 
within the input box, the text will scroll automatically.

2.3.3         Check Boxes  
Some dialog boxes also have check boxes.    An X inside a square indicates that that option is 
set ON.    An empty box indicates it's OFF.    You set a check box to the ON- or OFF-state by 
clicking on the square or by clicking on the text immediately to the right of the square.    (If 
you don't have a mouse, press the <TAB> key one or more times until the check box is 
highlighted and then press the Spacebar.    Alternatively, you can turn a check box ON or OFF
(toggling) by holding the Alt key down while typing the highlighted letter (if one is 
provided).    Any number of check boxes can be checked ON at any one time.

If several check boxes are grouped together, pressing the <TAB> moves to the next group 
and once the group is selected, you can use the up-down arrow keys to highlight the check 
box you want within the group, and then press the Spacebar to turn the individual check box 
ON or OFF.    On monochrome monitors, POPMail indicates the highlighted check box or 
group of check boxes by placing a chevron symbol (») next to it.    When you press <TAB>, 
the »    symbol moves to the next check box or group of check boxes.

2.3.4         Radio Buttons  
Radio buttons work just like check boxes, except that one and only one radio button in a 
group is ON at any one time.    Since only one radio button in a group can be ON at a time, 
any other button in the group which was previously turned on is turned OFF automatically 
when you select another.      

2.3.5         List Box  
A list box lets you scroll through a list of choices.    You activate a list box by clicking in it or 
by pressing the <TAB> until it's highlighted.    Once a list box is active, you can use the 
mouse to manipulate the scroll bar (or if you don't have a mouse, press the up-down arrow 
keys to move within the list).

(Note    Inside a dialog box, any item with a highlighted letter indicates that that particular 
gadget can be accessed by holding the ALT key down while typing that highlighted letter.)
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2.4           Editing Text  
POPmail contains basic word-processing features.    Anywhere in POPmail, the <DEL> key 
deletes text forward from the current cursor position, and the <backspace> key deletes text to
the left of the cursor position.    Except within a modal dialog box, you can use the mouse to 
drag over (select) text to be cut or copied. Without a mouse, you select text by holding the 
Shift key down and using the arrow keys to expand the amount of text selected, starting with 
the current cursor position.    Once the text is selected (highlighted) you can cut the selected 
text, by selecting Cut from the Edit menu.    Likewise, to copy selected text, select Copy from
the Edit menu.    Once selected text has been cut or copied, it is stored temporarily in 
POPmail's clipboard.    To paste the text contained in the clipboard, position the cursor in the 
desired location and then select Paste from the Edit menu.

POPmail does not support underlined, bold, or italic text.

Users who are familiar with WordStar are advised that the POPmail editor also supports the 
WordStar Control Key sequences for cursor movement (Ctrl-E = Line Up; Ctrl-R = Page Up;
Ctrl-F = Next Word; Ctrl-Y = Delete Line, etc.).

3. Installation

3.1           System Requirements  
In order to run POPmail, your microcomputer must be connected to a local area network 
(LAN).    Usually, the LAN will be connected to the campus backbone network, allowing you
to send and receive mail outside your local work group.

In order for your microcomputer to operate on the LAN, you must have a network adapter 
card installed in your microcomputer.    In order to run POPmail, your network adapter card 
must be one of those supported by the Clarkson packet drivers, as explained in the following 
sections of this manual.    (Each Clarkson packet driver is a specialized piece of software 
designed to talk to a specific type of network adapter card.    For a list of network adapter 
cards currently supported by the Clarkson Packet Drivers, please consult our accompanying 
documentation entitled "Installing the Clarkson Packet Drivers".)

POPmail runs under DOS version 3.0 or greater and requires 640K of RAM.    POPmail was 
designed to run on a wide range of IBM PCs and compatibles, including the earliest PCs 
which contained only a monochrome display adapter (no graphics support).

A Microsoft-compatible mouse is helpful but optional.    You must load mouse driver 
software into your system before running POPmail.    Note also that if your mouse contains 
more than one mouse button, you will be using only the left mouse button when running 
POPmail. 
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3.2           How to Obtain POPmail  
POPmail software consists of two components a Clarkson Packet driver (matched to your 
microcomputer's network adapter card) and the POPmail program software itself.    All the 
software components and their manuals are included on the POPmail diskette, or they may be
obtained on the internet through anonymous FTP from

boombox.micro.umn.edu

Look in the UNIX directory called

/pub/POPmail

3.3           Loading the Clarkson Packet Driver  
You install the appropriate Clarkson packet driver according to the installation instructions 
contained in our manual entitled "Installing the Clarkson Packet Drivers."    In order to run 
POPmail, the appropriate Clarkson packet driver must be loaded into RAM (random-access 
memory) each time you boot-up your computer.    To do this, you first run the appropriate 
packet driver by typing the packet driver name, followed by the necessary parameters, as 
described in the manual.

After you have installed the appropriate packet driver, copy the POPMAIL.EXE file into a 
directory.    If you want to be able to run POPmail from any directory, modify the PATH 
statement in your AUTOEXEC.BAT file to include the directory containing POPMAIL.EXE. 
Then, you can run the POPmail program by typing    "POPMAIL" at the DOS prompt.

The following two command lines represent an example of the steps needed to load the 
packet driver and start POPmail (of course, the specific packet driver and parameters will 
depend on your configuration).    Type each line following the command prompt and end each
line by pressing the <ENTER> key

          3C523 0x60 0x3 0x300
          POPMAIL 

At this point you are running POPmail.    As long as you do not turn the power off to your 
computer, you can quit POPmail and do other things and then start POPmail again without 
re-loading the Clarkson packet driver.    Also if you already have the packet driver loaded for 
other programs like FTP, Telnet, or tn3270, you do not need to re-load the packet driver 
before running POPmail.

3.4      Configuring POPmail
When you use POPmail for the first time, you need to set up POPmail parameters.    POPmail
needs these configuration parameters in order to identify you and your computer on the 
network.    When you run POPmail for the first time, POPmail will display the "Configure" 
dialog box shown in Figure 3A, allowing you to enter the required parameters. You must 
enter all of the parameters, according to the instructions which follow.    (Consult your 
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network administrator for the correct parameter information.)    Space for entering multiple 
name servers and gateways is provided, but only one of each is required.    You will not need 
to enter parameter information during subsequent POPmail sessions, because POPmail will 
permanently remember the parameters you have entered.    You can modify your 
configuration settings at any time by selecting Configure from the Options pull-down menu.

Figure 3A    First Time Users

Initially, the User Name line will be empty and highlighted.    Since it is already selected, you
can simply type in your User Name.    To enter or edit Password, Host computer, or any of the
other parameters in the Configure dialog box, use the <TAB> key (or Up and Down arrow 
keys) to advance to the appropriate parameter field.    Then enter the appropriate parameter 
information. (As a short-cut you can select any of the parameter names by holding down the 
Alt key while typing the highlighted character in that parameter name, e.g., type Alt-P to 
select the Password parameter name.    Remember In general, we use a capital letter to 
designate a highlighted letter within a dialog box.)

A brief description of each of the parameters follows

3.4.1         User Name  
Initially, the User Name line will be empty and highlighted.    Since it is already selected, you
can simply type in your User Name.    This User Name corresponds to the User Name 
(sometimes called the account name) that has been assigned to you for use on the host mail 
server.    Generally, the host mail server will be a Unix machine, and by convention, Unix 
machines use all lower-case letters, so be careful not to capitalize letters in your user name 
when they shouldn't be.

3.4.2         Password  
The Password is the key word that the host mail server uses to validate your user name.    The
person who sets up your account on the host mail server will assign you this password.    
Warning    Be sure to type in your password exactly as it was assigned, (again, be careful of 
upper- and lower-case considerations).    Note that when you enter your password in the 
Configure dialog box, you will not see your actual password displayed on the screen.    This 
is a security feature of the POPmail program, since it prevents people from viewing your 
password as you enter it.

3.4.3         Host Computer  
This is the name or IP address of the computer you are using as a host mail server for running
POPmail.    Every computer on the TCP/IP (world-wide) network has a unique numerical 
address called an IP address.    The IP address looks something like 128.101.63.1.    In much 
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the same way as the post office uses home addresses to distinguish one residence from 
another, the network uses IP addresses to distinguish one computer from another when 
delivering electronic mail.    In addition to having an IP address, each computer on the 
network often has a name, e.g., vx.acs.umn.edu.    Although both the IP address and name are 
unique for each computer, they don't have equal status.    Specifying the host mail server's IP 
address will always work to identify the host computer successfully, while specifying its 
name identifier may not always work.    You can use either the host computer name or IP 
address.    The advantage in using the name, although it is less reliable on the network, is that 
it's easier to remember a name than it is to remember a series of numbers.    If you use a 
name, the name will be converted to an IP address by a computer on the network called a 
name server.

3.4.4         Microcomputer IP address  
This is the IP address of your individual microcomputer or workstation.    See your network 
administrator for a microcomputer IP address assignment.

3.4.5         Subdirectory for Mail  
POPmail writes a copy of each message you receive to a file on your personal computer, one 
file per message.    This parameter specifies the drive and subdirectory for POPmail to use 
when saving your messages.    If this subdirectory does not exist on your disk, POPmail will 
ask you if you would like to create a new subdirectory when you exit the dialog box.    (Note 
POPmail will also ask you if you would like to create the subdirectories called ENCL and 
ENCL\RSRC within your subdirectory.    See the section called "About Enclosures" for more 
details.)        

3.4.6         Gateways  
A gateway is a device which gives your computer access to the outside world, by transferring
information from one type of network to another.    If you want to use POPmail to send 
messages beyond your local area network (LAN), you must specify the IP address of one or 
more gateways to which your LAN has access.    If more than one gateway is available to 
you, it is to your advantage to enter more than one, increasing the chance that you will find 
one that is up and running when POPmail needs it.    A gateway moves your POPmail 
information off your LAN and routes it on to the outside world.    Contact your network 
administrator for the IP address of gateways accessible to your LAN.

3.4.7         Name Servers  
As discussed earlier in the "Host Computer" section above, a name server converts a host 
mail server name into an IP address.    You type in the IP address of your name server in this 
parameter field (see your network administrator for the value to enter). If more than one 
name server is available to you, it is to your advantage to enter more than one IP address, 
increasing the chance that you will find a name server that is up and running when POPmail 
needs it.

POPmail/PC - 16 -



3.4.8         Time Zone  
Figure 3B shows the Time Zone List Box which pops up when Figure 3A's Time Zone 
software button is activated.    The Time Zone List Box allows you to indicate your time 
zone, if you are not located within the Central Standard Time zone of the United States, 
which is the default setting.    To indicate your time zone, use the scroll arrows or the up-
down arrow keys, to select your time zone from the list.    Once your time zone is highlighted,
type the <ENTER> key or click on the oK button.

Figure 3B Time Zone List Box

3.4.9         Language  
Figure 3C shows the Language List Box which pops up when Figure 3A's Language software
button is activated.    The Language List Box allows you to indicate the human language (e.g.,
Swedish, English, etc.) you use to communicate.    To indicate your chosen language, use the 
scroll arrows or the up-down arrow keys, to select your language from the list.    Once your 
preferred language is highlighted, type the <ENTER> key or click on the oK button.

Figure 3C Language List Box

3.4.10       Advanced  
Most users will not have an occasion to use the Advanced... software button in the Configure 
dialog box.    POPmail has default parameters which are appropriate for most network 
environments.    However, if you encounter problems in installing or using POPmail on your 
network, consult your network administrator to see whether it might be helpful to alter the 
Advanced configuration parameters described in the next section.

When you have finished entering the parameters, click on the oK button to have POPmail 
save your changes to the configuration.    If you decide you don't want your parameter 
changes to be saved, click on the Cancel button.

3.5           Advanced Configuration Parameters  
The Advanced Configuration Parameters dialog box is designed to provide network 
administrators with more advanced and specialized configuration parameters, in case they are
needed to install POPmail on network environments which have unique or unusual 
requirements (see Figure 4).    Network administrators can set these specialized parameters by
activating the Advanced... software button found within the Configure dialog box.    POPmail
has appropriate default settings for these advanced parameters, which in our experience are 
suitable for most networks.    However, if you encounter problems in installing or using 
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POPmail on your network, your network administrator may need to alter the Advanced 
configuration parameters.

When the Advanced... software button is activated, the following advanced configuration 
parameters are displayed

Figure 4    Advanced Configuration Parameters

3.5.1         Preferred Full Name  
This is your full name in real life, e.g. John A. Doe.    POPmail gets your full name from the 
SMTP server so you should be able to leave this field blank.    You can use this field to 
override the information returned by the server.

3.5.2         Net mask  
The net mask parameter has to do with how your local area network is configured and 
connected to the backbone network at your worksite.    Your network administrator will know
the correct value to enter here.    Most sites are configured to use a net mask of 255.255.255.0
(the default value).

3.5.3         Domain request timeout  
This parameter sets the maximum number of seconds allowed for the name server on the 
network to convert your computer's host mail server name to an IP address.    The default 
value is set to 20 seconds.    If an error dialog box is displayed stating "Domain name request 
failed" when trying to send or fetch messages, you may need to increase this value.

3.5.4         Connect timeout  
When POPmail attempts to connect to the host mail server, this parameter sets the maximum 
number of seconds POPmail will wait before the host mail server will acknowledge your 
attempt to connect.    The default value of 20 seconds is sufficient for most mail servers.    If 
an error dialog box is displayed stating "Open failed" when trying to send or fetch messages, 
try increasing this value.

3.5.5         I/O timeout  
This parameter sets the maximum time allowed for POPmail to send and receive data from 
your computer to the host mail server.    With the default value of 20 seconds, POPmail will 
wait 20 seconds for a response from the host mail server.    If a response does not come 
through within 20 seconds, POPmail will present an error dialog box stating "error reading 
from network" or "error writing to network" and will abort the Send or Fetch operation in 
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progress.    Again, if your host mail server is slow and frequently times out, you may need to 
increase this parameter value.

3.5.6         Retransmit timeout  
This parameter sets the length of time in seconds POPmail will wait before retransmitting a 
packet whose earlier transmission was not acknowledged.    The default is one second.

3.5.7         Max transmit unit in bytes    MTU  
This parameter specifies the maximum allowable packet size that POPmail will transmit in 
bytes.    The default is 1024 (1K) bytes.

3.5.8         Max segment we can receive    MAXSEG  
This parameter specifies the maximum size packet in bytes that a host mail server is allowed 
to transmit to POPmail.    The default is 1024 (1K) bytes.

3.5.9         Most bytes we can receive without ACK  
This parameter sets the maximum send/receive TCP window size in bytes.    The default is 
2048 (2K) bytes.

3.5.10       POP port  
This parameter specifies the port POPmail will use to connect with the POP server.    The 
default value is port 109.    This is the default POP2 port.    If you are using a mail server that 
uses the POP3 protocol you will probably need to change this value to 110.

3.5.11        Finger port  
This parameter sets the port the Finger command will use when using the Finger desk 
accessory.    The default value is port 79.
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4.    The Composer Window

4.1           Sending Mail to Other Users  
Using POPmail to send an electronic mail message is easy.    Just follow these steps

1. Make the Composer window the active window.
2. Specify the recipient of the message.
3. Specify recipients of carbon copies, if any.
4. Specify the subject of the message.
5. Type the message itself.
6. Send the message.

Make the Composer window the active window.
Press the F8 function key.    This will make the Composer window active.    (The active 
window always appears in front of all other windows.)

Specify Recipient.
In order to send a letter to someone through the United States mail, you must know their 
name and address.    Likewise, to send an electronic mail message to someone, you need to 
know their electronic name and address.    This is commonly called their E-mail address.

You place the recipient’s E-mail address into the POPmail field labeled To.    (Initially, the 
cursor is positioned in the To field).    In order to move the cursor between fields, you press 
the <TAB> key or simply click in the desired field with your mouse.    Then type the 
recipient's E-mail address.    Figure 5 shows a sample message in the Composer window.

Figure 5    POPmail screen with the Composer window visible

            ∫        Options        Edit          Group        Memo        Window
          
                  Alt-X    Exit          Alt-F    Fetch          F3    Prev Msg          F4    Next Msg            F7    View          F8    Compose

In this example, the message is being sent simultaneously to two people.    One recipient is 
someone whose E-Mail address is

kathy@boombox.micro.umn.edu

(This address is read kathy at boombox dot micro dot umn dot edu.    The address denotes a 
person whose E-mail user-name is kathy.    Kathy gets mail at a computer called 
boombox.micro.umn.edu on the Internet.)
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To send the same message to more than one person, enter additional E-mail addresses 
separated one from the other by one or more spaces (a comma is optional).    The message in 
Figure 5 is also being sent to

ellen@UMNMOR.BITNET

(a recipient named ellen who gets her mail at a computer called UMNMOR on BITNET).    
You can send the same message simultaneously to as many recipients as you wish.

Specify Carbon Copies.
With POPmail you can send a message directly to some people and as a carbon copy to 
others.    After specifying the primary recipients of your message in the To field, press the 
<TAB> key once to enter the CC field where you can enter E-mail addresses of the people 
who are to receive “carbon copies” of the message.    To send carbon copies to more than one 
person, enter additional E-mail addresses separated by one or more spaces (a comma is 
optional).    Those who receive messages see E-mail addresses of both the primary and the 
carbon copy recipients of the message.    If you don’t want to send carbon copies of your 
message, you may leave the CC field blank.

Specify Subject.
You must fill in the Subject field.    To move to this field, press the <TAB> key.    Once your 
cursor is in the field, type a succinct one-line description of your message.    Be courteous and
wise; use this field to describe the contents of your message briefly but clearly.    The subject 
of our sample message is “Next Committee Meeting”.

Type the Message.
The big field just below the Subject field is the Message field.    This is where you will enter 
the body of your message.    To move the cursor to this field, press the <TAB> key again.    
Once your cursor is in the field, type your message.    Editing text here is easy.    You can use 
the arrow keys to move around in the text and use the <backspace> and <DEL> keys to 
delete text.    The current version of POPmail support s word-wrapping; therefore, you only 
need to type the <ENTER> key at the end of paragraphs.    You can also use the WordStar 
control key sequences for cursor movement.    POPmail uses a simple version of a word 
processor and has some limitations.    For example, you cannot make text bold, italic or 
underlined.

Send Mail.
When you are done typing your message click on the Send button.    (Alternatively, type 
Alt-S;    or press the <TAB> key until the Send button is highlighted and then press 
<ENTER>).    The message will be sent to the recipients you specified in the To and CC 
fields.    When the message has been sent to the mail-server, a confirmation dialog box is 
displayed.    Click on the OK button or press the <ENTER> key to clear the confirmation 
box.
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4.2           Sending Mail to a Group  
Sending POPmail to a group is as easy as sending a message to one person.    With POPmail 
you can keep group lists.    A group is simply a list of recipients (E-mail addresses) that have 
been given a one-word alias (identifier).    For example, you could create a group called Marx
composed of these three E-mail addresses

harpo@squeezebox.circus.umn.edu
groucho@cigarbox.opera.umn.edu
chico@bandbox.hollywood.umn.edu

To create a group alias name, select the "Make Group..." menu item from the Group pull 
down menu.    An edit box with scroll bars will appear to allow you to enter the desired alias 
name and the recipients you want to include in the group.    When you define a Group, you 
must type the group name first.    In our example, shown in Figure 6 below, committee1 and 
committee2 are group names.    The group names are followed by the user names of the 
members of the group.    Within a group, each user name is separated from the next by one or 
more spaces (commas are optional).    When you are finished entering the user names for one 
group, type the <ENTER> key twice before entering information to define another group.    
(Groups must be separated by a blank line.)

Figure 6    Making Groups

When you have finished making groups, click on the oK button to save your changes.

4.2.1         Selecting a Predefined Group  
To send mail to a group you have already defined, select the "Select Group..." menu item 
from the "Group" pull down menu.    A list box with a vertical scroll bar will appear, giving 
you a list of all your group alias names, as shown in Figure 7.    Select the group name by 
typing the up and down arrow keys until the desired group name becomes highlighted.    Then
click on the Select button to select that group.    The "To" field of the Composer window will 
be filled in automatically with the full E-mail addresses of the members of the group; the 
group alias name itself does not appear in the To box.

Figure 7    Select    a Predefined Group 
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4.3           About Enclosures  
POPmail allows you to enclose files, such as an Excel chart or worksheet, or a memo created 
with Microsoft Word, with each mail message.    Each recipient of your message receives an 
exact copy of the enclosed files.    (Of course, to receive an enclosure from POPmail, the 
recipient must be running POPmail/PC or POPmail/Macintosh.)    Enclosed files appear on 
the recipient's disk with their original contents.    Your recipient can peruse and modify the 
file and, if desired, return it to you as another POPmail enclosure.

When the POPmail program receives a message with an enclosed file, the document is stored
on your disk.    POPmail automatically stores the enclosure in a subdirectory named ENCL of
the directory you specify for mail (see Configuring POPmail).    For example, if you specify 
the C\POPMAIL\MAIL directory for incoming mail, POPmail places your enclosures in the 
directory C\POPMAIL\MAIL\ENCL.

Since enclosures are regular files, you can treat them as you would any other file; that is, if 
someone sends you an enclosure containing an executable program, you can run the program 
on your machine as well. In addition, an IBM enclosure containing graphics, italic or bold 
characters, or spreadsheets, will retain all its original characteristics.    In short, sending IBM 
files as enclosures is really no different than transferring files from one machine to another 
using a diskette.

4.3.1         Receiving Enclosures from a Macintosh  
Macintosh files are somewhat more complicated than IBM files.    First, Macintosh files can 
have longer and more complicated file names, so if necessary, POPmail/PC will alter the 
original Macintosh file name in order to comply with DOS file name requirements.    Second,
Macintosh files are divided into one or two forks (parts).    Part One, called the "data fork," is 
completely equivalent to a data file on a DOS computer. Part Two, if present, is called the 
"resource fork."    The resource fork contains special Macintosh-only information.    If an 
enclosure is coming from a Macintosh, POPmail will store the data fork of the document in 
the subdirectory called ENCL.    If the document also contains a resource fork, the resource 
fork portion of the document will be stored in a subdirectory of ENCL called RSRC.    For 
example, if someone sends you a Macintosh HyperCard stack called "French," POPmail/PC 
will divide this incoming Macintosh document into two parts.    Part One the data fork, would
have the name

C\POPMAIL\MAIL\ENCL\FRENCH

Part 2 (the resource fork), would have the name

C\POPMAIL\MAIL\ENCL\RSRC\FRENCH

Actually, the information contained in the resource fork is useless to the IBM user; however, 
if someone sends you a HyperCard stack, you may want to pass it on to another Macintosh 
user without losing any information.    That is why POPmail saves the resource information 
on the PC even though PCs don't have any way of using Macintosh-style resources.
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4.3.2         Sending Enclosures to a Macintosh  
It is possible to send enclosure files to a Macintosh, as well as receive them.    In fact, many 
of the newer applications, such as Microsoft Excel, have compatible data formats.    They 
achieve this by using only the data fork on the Macintosh and storing the data in compatible 
formats.

In general, if you are creating files on the IBM for later transmission to a Macintosh via 
POPmail, you must be careful to assign the correct file extension to your file name.    The 
Macintosh then will be able to assign the proper system icon, etc. to the IBM file when 
received.    For example, if you are using Excel on an IBM and want to send the Excel 
spreadsheet to a Macintosh user, your file name must have a file name extension of .XLS.    
The recipient will be able to receive and modify the spreadsheet with no problem, and then 
send the modified spreadsheet back to you.

Here are other important file extensions to employ when sending IBM files to a Macintosh

      DOS EXT. Mac Application      Mac Document Type
      ====     =========            ===========
     .XLS      MS Excel 2.2         spreadsheet
     .WKS      MS Excel 2.2         spreadsheet
     .WK1      MS Excel 2.2         spreadsheet
     .PAS      Turbo Pascal 1.1     program source
     .TXT      MacWrite II          ASCII text
     .BAT      MacWrite II          ASCII text
     .C        MS Word 4.0          ASCII text
     .CPP      MS Word 4.0          ASCII text
     .DOC      MS Word 4.0          internal
     .RTF      MS Word 4.0          RTF

4.3.3         Problems with Exchanging Documents  
Those who exchange documents with others (via POPmail or even floppy disk) using 
different versions of the same software soon learn that they cannot always save, open, read, 
or retrieve documents in the usual manner.    New versions of the software can usually open 
or read documents created with older versions, but older versions do not recognize 
documents created with newer versions.    However, newer versions of the software usually 
are backwardly compatible in that they contain an option for reading and writing documents 
in the old (obsolete) formats.

Exchanging computer documents is generally straightforward when you and the recipient use
exactly the same version of the same software; for example, when you both use WordPerfect 
5.1.    However, even in this scenario, if the recipient does not have the font you used to 
create the document, they probably will not be able to see the document as you intend it to be
reproduced - either on the screen or on a printer.
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Whenever Microsoft Word users want to exchange documents but are unsure of the 
recipient's software, they should save the document as an RTF (rich text format) document.    
Documents saved in this manner are compatible with all versions of Word on the IBM and 
the Mac, as well as with some other word processing programs.    Word 5.0 users will see the 
RTF document's name show up in the Transfer/Load menu if the document's name ends 
in .DOC.    If the document's name does not end in .DOC, Word 5.0 users must type in its 
name to load the document.    The newer Word 5.5 is more flexible; it has an option that lets 
you view a list of all documents regardless of their names.

Some software comes with built-in file converters.    For example, Microsoft Word for 
Windows 2.0 includes converters for several word processing packages, such as Word for 
DOS, Word for Macintosh, Windows Write, WordPerfect 5.1, and WordPerfect 4.2.    When 
you install Word for Windows this conversion feature is automatically copied to your 
working disk.    Not all software makes using its conversion features so easy to use.    Some 
software requires that you follow special installation instructions to use their converters.

Finally, keep in mind that when you E-mail large documents or multiple enclosures, you can 
bog down a network.    To avoid congestion, consider these strategies send only one enclosure
per mail message; break up large documents into smaller documents; and mail your 
documents during off-peak hours.

As you can see, enclosing E-mail documents is not always straightforward.    The less you 
know about the recipient's hardware and software setup, the more likely you are to run into 
unforeseen problems.

4.3.4         Sending Enclosures  
When sending a message, it is often desirable to enclose another file within your message.    
For example, you may want to send a message notifying others of an upcoming committee 
meeting, and enclose a copy of a map indicating directions to the meeting site.    If you push 
the "Enclose..." button in the Composer window shown in Figure 5, POPmail will display the
modal dialog box shown in Figure 8.

Figure 8 Choose file to enclose Dialog Box

The list displayed in Figure 8 is simply a list of all the files contained on your disk.    The 
information at the bottom is provided to give you further information about the file you are 
proposing to select as an enclosure.    This helpful information includes drive, path, and file 
name information, the file size in bytes, and the date and time the file was last modified.    To 
select a document to be sent with the current outgoing message, click on the file name 
desired and then click on the oK button.    At this point, POPmail returns you to the 
Composer window.    The enclosure file name will be displayed on the bottom of the 
Composer window (on the window frame) to remind you that you have selected an 
enclosure.
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If you hold down the shift key while you push the "Enclose..." button in the Composer 
window shown in Figure 5,    you will invoke a dialog box identical to that shown in Figure 8,
except that the dialog box will be retitled as "Choose TEXT file to add to message".    You 
can then choose an ASCII text file that will be appended to your message body when the 
message is sent.    You can use this feature to send ASCII text files to others who are not 
using POPmail and cannot accept BINHEXed enclosures (the normal method POPmail uses 
to send enclosures).

4.3.4.1     Sending multiple enclosures
If you select the Enclose... button from the Composer window after you have already 
selected one enclosure, you will see the dialog box shown in Figure 9.

Figure 9 Add/Remove Enclosures Dialog Box

To add additional files to POPmail's enclosure list for the current outgoing message, click on 
the "Add..." button.    Then POPmail will display the modal dialog box called "Choose file to 
enclose" (Figure 8) on top of the Add/Remove Enclosures Dialog Box (Figure 9).

For each enclosure you wish to send, repeat this sequence, choosing one file at a time, until 
you have chosen all the desired enclosures.    If you find that you have selected an incorrect 
file, you can click on (highlight) the incorrect file name in the list shown in the Add/Remove 
Enclosures dialog box (Figure 9) and then delete it by clicking on the Remove button.    
When your list of enclosures is complete and correct, click on the Done button in the 
Add/Remove Enclosures Dialog Box, and POPmail will return you to the Composer window.

Note    If you hold down the shift key while you push the "Add..." button in the Add/Remove 
Enclosures Dialog Box (Figure 9), you can then choose an ASCII text file that will be 
appended to your message body when the message is sent.    You can use this feature to send 
ASCII text files to others who are not using POPmail and cannot accept BINHEXed 
enclosures (the normal method POPmail uses to send enclosures).    File names which appear 
in upper case letters in the list box shown in Figure 9 will be sent as BINHEXed enclosures.   
File names which appear in lower case in the list box shown in Figure 9 are ASCII text files 
which POPmail will append to your outgoing message.

5.    The Viewer Window
5.1           Fetch Incoming Mail  
Your incoming mail is held for you at the post-office server until you fetch it. When you 
fetch incoming mail, each message is moved from the mail server to the POPmail 
subdirectory you have specified.    Incoming messages remain in your database until you 
explicitly discard them.
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To retrieve your new messages, click the Fetch button on the Viewer window (Figure 10 
below).    (No matter which window is currently active, you can type Alt-F to make the 
Viewer window active and Fetch your mail.)    POPmail will present you with a dialog box to 
inform you whether or not you have mail.    Then POPmail will display the first new message
in the Viewer window. 

Figure 10 POPmail screen with the Viewer window visible

    ∫      Options      Edit        Group     Memo      Window
 
    Alt-X    Exit          Alt-F    Fetch          F3    Prev Msg          F4    Next Msg            F7    View          F8    Compose

If you are connected to a printer, you can print the message by selecting Print from the File 
pull down menu.    If you want to delete the message click on the Delete button in the Viewer 
window.    If you don’t delete the message, it will remain in the database.

5.2           Paging through the Database  
Messages are stored in the database in the order they were received.    Each new message is 
stacked on top of its predecessor, just like file cards on a stack.    To move backwards in the 
database (view the previous message), press the F3 function key.    To move to the next 
message in the stack, press the F4 function key.

If you save a copy of your outgoing messages (specified in the Preferences dialog box shown
in Figure 11) from the Options pull-down menu, each outgoing message will be stored in 
order at the end of your POPmail database.

Each incoming message is saved to a file on your disk in the subdirectory you specify in the 
Configure dialog box (see Figure 3A). The name of each file is stored near the end of the To 
field along with the complete SMTP header.    (More advanced users may wish to scroll down
the To field to view or retrieve this optional information.    This feature is useful because 
POPmail will only display the first 45K of the message body.    If the message is larger than 
45K in size, you would want to know the file name of the message so that you could retrieve 
it from disk and view it with some other word-processing program capable of reading 
arbitrarily large files.)

5.3           Reply to Incoming Mail  
One important difference between the Viewer window and the Composer window shown 
earlier in Figure 5 is that the Viewer window includes a REPLY button.    The Reply button 
allows you to respond to an incoming message quickly, since POPmail automatically takes 
the Subject field and From field information from the original message and fills it into the 
Subject field and To field in the Composer window for your reply.    When you are finished 
typing your reply, you click the Send button to send your message.
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5.4           Forwarding Mail  
If you want to forward the message displayed in the Viewer window on to another user, click 
on the Forward button found in the Viewer window (Figure 10).    POPmail will move the 
message into a Composer window, and fill in all necessary information automatically.    The 
Composer will be filled in as follows the subject field will be prefixed with the text 
"Forwarded->" and the text in the body will be prefixed by a line indicating who wrote and 
sent the original message.    All you have to do is enter the appropriate user address in the To 
field.

6. Setting Program Preferences
POPmail is designed so that you can customize the program to meet your needs.    To 
customize POPmail, select "Preferences..." from the File pull-down menu.    The Preferences 
dialog box shown in Figure 11 will appear.    Use the mouse to click in the little box to the left
of each option in order to toggle the preference ON or OFF (when an X appears in the box to 
the left of preference, it is turned ON).    (Using the keyboard you can toggle a preference by 
pressing the Alt key together with the letter that is highlighted for the preference in question; 
or, press the <TAB> key repeatedly until the desired preference is selected [highlighted] and 
then press the Spacebar to toggle that preference ON or OFF.)    The default values are pre-set
by POPmail to the values shown in Figure 11.    If you don't like these default values, you are 
free to change them at any time.    POPmail permanently remembers your settings.

Figure 11 Preferences Dialog Box

The first preference option in Figure 11 is "Include incoming message in Reply".    This 
feature is used in conjunction with the Reply button in the Viewer window (see Fig. 10). 
When there is a check in the square to the left of this preference, POPmail will collect the 
text in the incoming message and include it for reference as a preface to the reply you will 
formulate to the message while using the Reply feature on the Viewer window.    The text 
collected from the incoming message will appear before your reply, with a leader line stating,
" On [such and such a date] [so and so] writes ".    In addition, to further differentiate the 
incoming message from your reply which will follow in the message field,    POPmail places 
a greater than (>) symbol before each line of the incoming message.    You then type your 
reply following this reference text.    This feature is useful because it allows each recipient of 
your reply to consider your reply in the context of the original incoming message.

The second preference option is "Display POPmail's copyright screen".    When there is a 
check in the square to the left of this preference, POPmail will display the POPmail copyright
dialog box (POPmail's initial screen) whenever you start up POPmail.

The third preference option is "Add signature to outgoing mail."    When there is a check in 
the square to the left of this preference, POPmail will automatically end each of your 
outgoing messages with a signature block of your choice, as shown in the John Doe example 
in Figure 11.
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The fourth preference option is "Save copy of outgoing mail."    When there is a check in the 
square to the left of this preference, POPmail will automatically place a copy of each 
outgoing message into your POPmail database.    This convenient feature saves you a record 
of every message you send.

The fifth preference option is "Check for mail at startup".    When there is a check in the 
square to the left of this option, POPmail automatically fetches any mail waiting for you 
when you start POPmail.

The six preference option is "Prompt for password."    When there is a check in the square to 
the left of this preference, POPmail will require you to enter your password every time you 
start POPmail.    The password will not be stored in the configuration file.

The seventh preference option is "43/50 line mode as default."    When there is a check in the 
square to the left of this preference, POPmail will start with the program in the highest 
resolution mode allowed by your computer's video display adapter.    You can always use 
POPmail's Video mode command under the ∫ (system) menu to switch to low resolution 
mode (25 line mode) and back again as often as you wish.

7. Desk Accessories
POPmail has several desk accessories (small programs that you can run while you are 
running POPmail).    The POPmail desk accessories are    calculator, calendar, ASCII table, IP
finder, and Finger.    You activate a desk accessory by selecting the appropriate item in the ∫ 
(system) pull-down menu in POPmail's main menu bar.    A short description of each desk 
accessory follows.

7.1           Calculator  
The calculator is a simple four-function calculator.    Numbers and numerical operations are 
selected by clicking on the calculator buttons or by using the keyboard.

7.2           Calendar  
The calendar is a simple electronic calendar.    The current month appears automatically, but 
you can use the arrow keys or the calendar buttons to move to a future or past month.

7.3           ASCII Table  
Use this desk accessory to look up the ASCII codes for any character, including special 
foreign language characters.

7.4           IP Finder  
This desk accessory will look up the IP address of any internet name.
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7.5           Finger  
You use the Finger desk accessory to look at the status of an account on a given machine.    
For example, if you can provide an E-mail address, Finger will tell you the person's name in 
real life, the last time the person logged in to his account, and other site-specific details.

At the University of Minnesota, you can use Finger as an electronic phone book. For 
example, to look up all people with the name Hickman at the University of Minnesota, you 
would specify HICKMAN@UMN.EDU.    Then Finger returns all information pertaining to 
Hickmans in the University phone book.

8. Other Features
8.1           Memo Editor  
The memo editor is a simple ASCII text editor that lets you open up multiple windows for the
purpose of importing and editing ASCII text.    Cut, Copy , Paste, New, Open and Save 
operations are supported, as well as a Find and Replace facility.    Memo Editor commands 
are accessed through the Memo and Edit pull-down menus located in POPmail's main menu 
bar.

8.2           Moving a Window  
You can move the Viewer and Composer windows, as well as dialog boxes, by using a mouse
or the keyboard.    Using a mouse, place the mouse cursor on the top bar of the window 
frame, press the left mouse button, and continue to hold the mouse button down while 
dragging the window to a new location, then release the mouse button.    Using the keyboard, 
press Ctrl-F5 (or select "Resize/Move" from the Window pull-down menu and use the four 
arrow keys to move the window.    Press <ENTER> when done.)

8.3           Resizing a Window  
The Clipboard window (you can view the clipboard by selecting "Show Clipboard" from the 
Edit menu) and the Trace Window (see the "Trace Facility" below) can be resized as well as 
moved.    To resize a window using the mouse, grab the lower right corner of the frame and 
press the left mouse button, dragging the mouse until the desired size is achieved; or, using 
the keyboard, select "Resize/Move" from the Window menu and use the arrow keys while 
holding the Shift key down.    Press <ENTER> when done.    In general, the Composer 
window, the Viewer window, and dialog boxes cannot be resized.    However, in 43/50 (high-
resolution) mode, you can click on the zoom box (the little square in the upper right-hand 
corner of the window) to change the window back and forth from full screen to half-screen.
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8.4           Trace Facility  
POPmail has a built-in trace facility to assist network administrators in trouble-shooting 
when POPmail fails to Fetch or Send properly.    If your network administrator is 
unsuccessful in trouble-shooting the problem, we can be more helpful if we receive trace 
output.    When tracing is turned ON, POPmail will write a detailed log of the transactions 
between the PC and the host mail server when messages are fetched or sent.    Then your 
network administrator can use this log to help locate the source of the problem.    You press 
Alt-F10 to display the Trace Options dialog box, as shown in Figure 12.

Figure 12    Trace Options Dialog Box

By default tracing is turned off.    You turn tracing on by selecting a trace destination, either 
to the trace window or to a file.

You can direct the trace output to a Trace window by choosing the ".. to  trace window" radio
button and then clicking on the oK button.    Then a movable and resizable Trace window is 
made visible and active.    You can scroll back through this window to see earlier messages.    
(The Trace window has an 4k buffer).    All new messages are always added to the bottom of 
the window.    If the Trace window gets covered by the Viewer or Composer windows, you 
can bring it to the front by successively pressing F6 (Next Window) until the Trace window 
appears on top of all other windows.    You can close the Trace window by clicking in the 
close box in the upper left-hand corner of the window or by pressing the <ESC> key.    Even 
if the Trace window is closed, transactions will still be recorded to the trace window, you just
won't be aware of them.    Remember, if you have closed the Trace window, you can make it 
visible again by pressing Alt-F10.

To direct Trace output to a file, select the "..to file" radio button, type the name of the file in 
the input box just to the right of this radio button, and then click on the oK button.    By 
default, POPmail uses the file name "POPTRACE.TXT".    If you enter PRN for the 
filename, the trace output will go to your printer.

The values you enter into the Trace dialog box are transient.    They are forgotten once you 
quit the POPmail program.    The Trace dialog box initial (default) settings are shown in 
Figure 12.    The four check boxes let you control the level of detail included in the trace 
output.

8.5           Program Switches  
The POPmail program has two advanced optional parameters called program switches.    
They are the /P and /BATCH options.

The /P switch allows multiple users to run a single copy of POPmail on a network, each user 
with a custom POPmail configuration file.    It also makes it possible for each user to choose 
among multiple sets of POPmail configuration files by specifying the path (location) of the 
desired configuration file.
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Using the /BATCH option allows you to find out how many incoming messages are waiting 
to be read.    When you use the /BATCH option, POPmail runs in a non-interactive mode; that
is, POPmail simply reports the number of messages waiting for you and then quits.    
POPmail sets ErrorLevel to the number of messages waiting.    In batch mode, you can also 
redirect the output.    You could use this option in a batch file to check whether any messages 
are waiting in your mailbox and if there are, run POPmail in interactive mode to retrieve and 
read them.

For example, to have POPmail use the configuration file in directory C\POP77 and run in a 
batch file so POPmail will report the number of messages waiting, you would use the 
following command at the DOS prompt when starting POPmail

                    POPMAIL    /BATCH    /PC\POP77

This sample batch file runs POPmail in interactive mode only if there are messages waiting

                    @POPMAIL      /BATCH      >NUL
                    @IF NOT ERRORLEVEL 1 GOTO QUITNOW
                    @POPMAIL
                    QUITNOW

8.6           Overloaded Buttons  
An overloaded button is a software button which performs a new function (other than the 
function originally intended) if the Shift key is held down while the software button is 
activated.

Shift-Send
Shift-Send will cause POPmail to make a copy of your outgoing message regardless of the 
setting chosen in the Preferences dialog box.

Shift-Discard
Shift-Discard will discard a message without further prompting.

Shift-Enclose
Shift-Enclose will allow you to append an ASCII text file to your outgoing message.

9. Summary and Cautions
POPmail is designed to give networked microcomputer users an easy-to-use E-mail system 
with wide connectivity.    While other Post Office Protocol software for the PC already exists,
POPmail/PC’s user interface mirrors the Macintosh POPmail user interface.    This 
consistency helps simplify training for departments that have mixed Macintosh and PC 
computing environments.
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Since there are many details to be considered in establishing a connection to the campus 
backbone network, we strongly advise that you consult the staff at the Microcomputer 
HelpLine before you plan your network or purchase any hardware.

If you want to discuss POPmail (or other E-mail systems), call or visit the Microcomputer 
HelpLine.    If you visit the HelpLine, our consultants can demonstrate POPmail for you.    If 
your department decides to run POPmail, we would be happy to help you set things up.
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10. Miscellaneous Technical Issues
10.1         Using POPmail with Novell  
Version 9.x of the Clarkson packet drivers will work with Novell NetWare.

First, you must access Novell NetWare by using a special IPX.    It requires
that you SHGEN a new one using the driver from BYU to create the interface
between the packet driver and NET3/4/5/X.    The BYU_IPX is a generic IPX that works with
any of the boards that use the packet driver, so if you have a mixture of 3COM, Novell 
Ethernet, and other boards you just need the appropriate packet drivers and the BYU version 
of the IPX.

Second, to configure the packet driver to work with Novell NetWare, simply add the -n 
switch to the command line immediately after the command to invoke the driver, before any 
other parameters.    For example, to invoke the packet driver for the 3COM 503 board, 
allowing for use with TCP/IP and Novell NetWare, you would use the following command 
line    
        c503.com -n 0x60 3 0x300
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10.2         Using POPmail with Windows 3.0  
Version 9.x of the Clarkson packet drivers will work with Microsoft Windows 3.0.    To 
configure the packet driver to work with Windows 3.0 or greater, add the -w switch to the 
command line immediately after the command to invoke the driver, before any other 
parameters.    This allows you to use Windows to invoke POPmail, Telnet, ftp, or tn3270 
directly.    For example, to invoke the packet driver for the 3COM 503 board, allowing for 
use with TCP/IP and to work with Windows 3.0, you would use the following command

3c503.COM -w 0x60 3 0x300

If you want to use Windows and Novell NetWare together, your command lines would look 
like this
        BYU_IPX.COM
        3c503.COM -n -w 0x60 3 0x300

In addition, you will need to set up a separate Windows .PIF file for each of the applications 
(POPmail, Telnet, ftp, and tn3270) with the following options so that Windows can run these 
packet-driver-dependent applications correctly

   Full screen                      ON
   Background execution             ON
   Close Window on Exit             ON

   Under "Advanced..."
         Background priority       100
         Detect Idle Time          OFF
         Lock Application Memory    ON
         Video Memory             TEXT
         Monitor Ports              OFF (i.e., all boxes off)
         Retain Video Memory        ON

The .PIF file should point to the .EXE files for each of these programs.          
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11. POPmail Questions & Answers
This section presents questions we are asked frequently concerning POPmail/PC.

-------------------------------------------------------------
Q.    Does POPmail PC have a "find message" feature?

A.    Currently, the answer is "no".    We are working on a message search, organizing, and 
archiving facility.    Right now the "database"-like features are modest.

-------------------------------------------------------------
Q. What can I do if POPmail says "Not enough memory
to run POPmail"?

A. The current version of POPMail needs at least 512K of free memory.    If you have a lot of
TSRs or your network software has a large resident portion, then POPMail will have trouble 
running.    Do a "chkdsk" or "mem" command to see how much free memory is left for 
applications.    You may need to remove some device drivers or reduce the number of files or 
buffers.

-------------------------------------------------------------
Q. How do I define a group in the "Edit Groups" window?

A. Groups are defined by listing a group name, followed by one or more spaces, followed by 
a group member's mail address, followed by one or more spaces, followed by another group 
member's mail address, etc. Put a blank line after the group to separate it from the other 
groups you have defined.

-------------------------------------------------------------
Q.    Is there a way to include a full name as a comment in the group listing so that they can 
be more easily identified?    For example for the alias "chairman" could I define a group as 
follows?

                  chairman                        jb@finsandfur.fw.umn.edu (Joe Blow) 

A.    No, there is no comment facility to do what you are attempting to do by putting a name 
in parentheses.    We suggest that you define the alias as the person's name. Then you can 
easily remember who it is when selecting the Select group... pull-down menu. For example, 
we suggest that you define the alias like this

            Joe_Blow    jb@finsandfur.fw.umn.edu

By doing this, you can select Joe_Blow off the list of groups rather than trying to remember 
who "chairman" is.

POPmail/PC - 35 -



Note    Spaces are separator characters; that is, they mark the end of names.    To denote a 
space within a name, use the underline character where a space would normally occur. For 
instance, define a group called AIS_CSO_Nameserver_Dude like this
          AIS_CSO_Nameserver_Dude        j-kuch@vm1.spcs.umn.edu
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-------------------------------------------------------------
Q.    We are running a POP3 server on port 110.    Can we use POPmail with this POP port?

A.    Yes.    To have POPmail use a port other than the default 109 port, simply specify the 
desired port in the Advanced Configuration Parameters dialog box (access this dialog box by 
activating the Advanced... software button in the Configure dialog box).

-------------------------------------------------------------
Q.    I just FTP'd POPmail/PC and tried to run the program. I get the error message "TCP 
Driver did not load".    What is wrong?

A.      This can happen if you forget to specify binary mode when doing the ftp.    Before you 
enter the “get” command, enter “binary.”    Sometimes we also see this problem if there are 
too many gateway hops, resulting in the file getting mysteriously truncated along the way.    
For some reason, we've seen this problem frequently when people ftp POPmail from our 
server to their site in Canada.    Other than forgetting to specify binary mode, we still are not 
sure why this phenomenon occurs. Often subsequent attempts will succeed where the first try
failed.    After you ftp, just make sure that you have the complete file by checking that you 
received the correct number of bytes as shown by the directory command (ls).

If all else fails, many people with this problem have had success when they ftp the 
compressed file version of POPMAIL.EXE (popmail.exe.Z).

-------------------------------------------------------------
Q.    In what format is the POPmail/PC manual?

A.    The manual is in 3 formats (1) man.hqx is in binhex format for Microsoft Word 4.0 on 
the Macintosh;    (2) man.rtf is in RTF (rich text) format, so you should be able to download 
and read this file with any version of Microsoft Word for the IBM; and (3)    man.txt is a 
straight-ASCII version of the manual.

-------------------------------------------------------------
Q.    I have a friend who gave me his access number on CompuServe.    Can I use POPmail to 
send him mail?    

A. • From internet to Compuserve
Compuserve addresses are of the form    nnnnn,nnnn    where n is 0 to 9.    For example, 

72555,3235.    Change the comma to a period and append @compuserve.com and you've got 
it.    For example, to send to 72555,3235 you would address your mail to

72555.3235@compuserve.com
• From Compuserve to internet
Preface the internet address with >INTERNET and you're done.    For example, to send 

mail to a user name fred with an account on an internet mail server named 
boombox.micro.umn.edu from Compuserve you would address mail to

>INTERNETfred@boombox.micro.umn.edu

-------------------------------------------------------------
Q.    Does POPmail support BOOTP?
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A.    We do support automatic configuration through BOOTP.    BOOTP is a protocol that lets 
you define all the parameters, IP address, gateways, and name servers at one central server.    
POPmail/PC interrogates the BOOTP server if the microcomputer IP address is 0.0.0.0.    In 
this way new users can just start up POPMail without knowing any IP numbers and POPMail
will configure itself.

-------------------------------------------------------------
Q.    We have more than one Packet Driver loaded.    POPmail can't seem to find the correct 
packet driver. What's going on?

A.    POPmail uses the first packet driver it finds.    Make sure the packet driver POPmail 
needs has the lowest interrupt number. You can ensure success by assigning it the lowest 
possible interrupt number    0x60.

-------------------------------------------------------------
Q.    Does POPmail/PC work on an AppleTalk network?
A.    We have tested POPmail with token ring and ethernet cards.    POPmail does not 
currently support LocalTalk, although we may add LocalTalk support at sometime in the 
future.

-------------------------------------------------------------
Q.    When I tried to use the 3C503 packet driver I was required to change the jumpers on the 
3C503 to allow shared memory.    This allowed me to run POPMAIL which looks like a real 
good product.    However when I reconfigured the PC to boot with PC-NFS it wouldn't work 
unless I set the jumpers on the 3C503 back to "memory disable" (note I didn't try to load 
3C503 packet driver).

A.    The packet driver for this particular hardware requires memory sharing, while PC-NFS 
disallows it.    One of our users recently learned from SUN of an undocumented "switch" 
(/m4) that can be used when loading the PC-NFS drivers for the 3c503 card.    For example, 
when you boot up for PCNFS, you load the following

Device= \NFS\DRIVERS\VECIE6.SYS /I2 /T2 /M4

This switch allows the PC-NFS drivers to use the 3c503 card jumpered for shared memory.    
This way one can use either the Clarkson drivers for telnet or POPmail or the PC-NFS 
drivers.    Of course, one can not use them at the same time; separate reboot sequences are 
still necessary.    But at least one needn't re-jumper the card to alternate between the two 
usages.

-------------------------------------------------------------
Q.    Can you run PC NFS and POPmail together?

A.    No, they can't both be running at the same time. PC-NFS and POPmail each have their 
own TCP protocol code.    They end up confusing each other.    The ideal solution would be 
for IBM to mandate one TCP driver that all applications must use, just as the packet-drivers 
are common low-level drivers all net applications use.
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Unfortunately, we are not aware of a simple common TCP driver which all TCP programs 
accept as standard.

You'll have to set up some way of switching autoexec.bat files to selectively load PC-NFS or 
POPmail, but not both at the same time.
-------------------------------------------------------------
Q.    Can you make POPmail a TSR?

A.    A POPmail TSR would be nice in theory, but it would take up about 80k of RAM.    Most
users don't want to or can't lose 80k without wreaking havoc upon their main applications.    
So while it would be an interesting exercise in programming, it's not too practical on DOS 
machines.    However, POPmail does have a batch mode that you can use to have POPmail 
report the number of messages waiting for you on the server (see the manual for further 
information).

-------------------------------------------------------------
Q. Where are the POP2 protocols described?

A. The description of the POP2 protocol is in RFC937.

-------------------------------------------------------------
Q.    Does POPmail use password encryption?

A.    We added DES encryption to the login sequence.    Our POP2 server makes up a random 
key and sends it to the client.    The client encrypts the password with the key and sends it to 
the server.    The server can then unencrypt the password and check it. By choosing the right 
defaults, we can keep the server and clients interoperable, i.e., the client can recognize our 
"extended" POP2 server by the presence of a key in the server's welcome message. Therefore
the client sends encrypted passwords to extended servers, and regular clear passwords to 
plain POP2 servers.    Similarly, our server accepts both encrypted and clear passwords 
interchangeably.    Therefore you can mix and match.    Our clients can talk to a standard 
POP2 or POP3 server, and other clients such as Eudora can talk to our server.    As another 
level of security, if our client determines that it is talking to a standard POP2 server, and must
send the password in the clear form, it sends the password 1 character per packet with long 
random delays between packets, instead of sending it all in 1 packet.    This disguises the 
password from all but the most knowledgeable of network peekers.    You can get our 
extended POP2 server by anonymous FTP from boombox.micro.umn.edu.    It is in 
/pub/POPmail/unix.

-------------------------------------------------------------
Q.    We are using POPmail/PC and when sending a file attachment to a Macintosh client that 
is using Eudora, the Macintosh client gets info stating the file needs to be BINHEXed.    
Why?

A.    There is a slight incompatibility between Eudora and POPmail's method of sending 
attachments.    Eudora will sometimes complain that there may be extra characters at the end 
of the attachment, or some similar message.    You can ignore the message as the attachment 
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is okay.    It is just that POPmail sends one harmless extra character in certain cases.    This 
triggers an error message from Eudora.

-------------------------------------------------------------
Q.    Where is the complete collection of the packet drivers?

A.    A complete collection is available via anonymous ftp from      sun.soe.clarkson.edu.
-------------------------------------------------------------
Q.    I am trying to install POPmail and I can't seem to connect to our POP server.    What's 
wrong?

A.    It's hard to say.    In order to tell whether something is wrong with the way your POP 
server is configured, try connecting to our POP server first.    We have an account on our POP
server which is specifically designated for testing POPmail.    Our POP server lives on 
boombox.micro.umn.edu (IP address 128.101.95.95).    User Name is testmail and Password 
is testmail.

-------------------------------------------------------------
Q.    Is there a version of POPmail that allows you to get your mail via a dialup connection?
I'm not interested in something that works on dialup slip, but rather something that just 
establishes a clean datapath between the PC and the pop and smtp mail servers...much like 
Eudora for the Macintosh allows you to do.

A.    The answer to your question is, “No, you cannot do what you ask.”    POPmail works 
over a SLIP connection for dialup use.    SLIP allows you to use network applications 
(POPmail, internet gopher, telnet, ftp, etc.) from home with exactly the same user interface as
when running these over a LAN connection.    Another advantage with SLIP is that you have 
end-to-end error detection (something not true of Eudora's dialup access method).

-------------------------------------------------------------
Q.    How are Swedish characters mapped?

A.    Before we answer your question, let's review how computers deal with characters.    Your
computer stores each character in an eight-bit chunk called a byte.    Depending upon the 
number stored in a byte, the byte can represent one of 256 characters.    A standard called 
ASCII has standardized the first 128 numbers to represent each of the characters necessary 
for the English language plus important symbols such as the dollar sign, period, and comma, 
and each of these numbers has been assigned a number.    For example, the number stored in 
the byte representing the dollar sign has been assigned the number 36.    This number is the 
same across all manufacturers, and this consistency makes it possible to exchange characters 
accurately from computer to computer.    Unfortunately, there is no standard for representing 
characters used in many other languages.    Since computer manufacturers want to sell 
computers to people who need other characters in order to communicate in their own 
languages, each manufacturer picks some arbitrary number beyond the first 128 numbers 
reserved by ASCII to represent each foreign character.    For example, the Swedish language 
uses a character called an "umlauted a" (an "a" with two dots over it).    An IBM computer 
uses the number 132 to represent a lower-case umlauted "a", whereas a Macintosh uses the 
number 221 for this same character.    Obviously, this difference causes a problem when 
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transferring text between an IBM PC and a Macintosh.    But, there is even a larger problem.   
When you send mail electronically, many mail programs will ignore any characters not part 
of the first group of 128 characters defined by the ASCII standard.    For this reason, many 
countries like Germany, France, and Sweden have decided to sacrifice certain ASCII 
characters in order to re-map or re-define these characters to accommodate the letter 
characters they need.    For example, the tilde character (~) is mapped to represent an 
umlauted "u" (a "u" with two dots over it) for the Swedish language character set.    POPmail 
makes the conversion automatically, so that two people using POPmail can exchange E- mail
written in Swedish without having letter characters appear as tildes or curly brackets at the 
other end.    Here are two tables showing how POPmail maps characters for the Swedish 
language when receiving and sending a POPmail message.    The IBM character code for 
each character is shown in the right-most column

Incoming Characters
     { --> ä  (a with 2 dots above)    132
     } --> å  (a with a ring above)    134
     | --> ö  (o with 2 dots above)    148
     ~ --> ü  (u with 2 dots above)    129
     ` --> é  (e with accent)          130
     [ --> Ä  (A with 2 dots above)    142
     ] --> Å  (A with a ring above)    143
     \ --> Ö  (O with 2 dots above)    153
     ^ --> Ü  (U with 2 dots above)    154
     @ --> É  (E with accent)          144
A.    Outgoing Characters
     ä --> {
     å --> }
     ö --> |
     ü --> ~
     é --> `
     Ä --> [
     Å --> ]
     Ö --> \
     Ü --> ^
     É --> @

-------------------------------------------------------------
Q.      I've installed POPmail for testing and I noticed that in the initial setup ( configuration ), 
I do not get a prompt for 'Full Name'.    Is this normal?

A.    That is normal.    POPMail gets your full name from the SMTP server.    This is to
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discourage forged mail.

-------------------------------------------------------------
Q.    What language is POPmail written in?

A.    Turbo C version 1.5, Turbo Assembler 1.0, and Turbo Pascal 6.0

-------------------------------------------------------------
Q.    How is the software in POPmail/PC layered?

A.    It is arranged like this

       POPmail main program (user interface)
             |
             |
       net mail (same code for Macs and IBMs)
             |
             |
       ibm tcp
             |
             |
       seg (all written in C and ASM)
             |
             |
       packet driver

The SEG code is really a C program that is loaded into a segment by the Pascal program, in 
this case POPmail.    The Pascal program then transfers control to the C program (written in 
the small memory model so it fits into one segment).    The C program then hooks an 
interrupt and returns control to the Pascal program.    When the Pascal program wants a TCP 
function it calls a routine in ibmtcp that then calls the C program via an interrupt.    SEG 
provides simple functions like open, close, read and write.
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